# User Control

## Part 1 Introduction and First Steps

1. User Accounts ................................................................. 2
2. First Installation ............................................................... 3
3. Subsequent Installations .................................................... 3
4. Enter Password ............................................................... 4

## Part 2 The Start Screen

1. Let's go - The "Start" page ................................................. 5

## Part 3 User Specific Settings

   - Startmenu ........................................................................ 6
   - Explorer ........................................................................... 8
   - Network ........................................................................... 9
   - Internet Explorer ............................................................ 10
   - Misc .................................................................................. 14
2. Security - Desktop Security ............................................... 15
3. Security - Window Title .................................................... 18
4. Internet .............................................................................. 19
   - Category Filter .................................................................. 19
   - Blocked ............................................................................. 20
   - Allowed ............................................................................ 21
   - Misc .................................................................................. 22
5. Programs - Overview ...................................................... 23
6. Programs - Details ............................................................ 25
7. Misc - Hide Drives ............................................................ 27
8. Misc - Kiosk Mode ............................................................ 28
9. Usage Logs - Charts ....................................................... 30
10. Usage Logs - Details ...................................................... 31
11. Usage Logs - E-Mail Report ............................................ 32

## Part 4 PC Specific Settings

1. Users .............................................................................. 34
2. Settings - General ............................................................ 35
3. Settings - Internet ............................................................ 36
4. Settings - Database/Network ............................................ 37
5. Settings - Exclusions ...................................................... 38

## Part 5 Special Functions

1. Menus .............................................................................. 39
2. Online Functions ............................................................ 40
3. Network Options ............................................................ 40

## Part 6 Questions, Answers and Support

42
<table>
<thead>
<tr>
<th></th>
<th>Contents</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>About the Trial Version ..................................................................... 42</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>System Requirements ......................................................................... 42</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Questions and Support ...................................................................... 42</td>
<td></td>
</tr>
</tbody>
</table>

Index .................................................................................................................. 44
Introduction and First Steps

Welcome to User Control
This program will help you guide your users computer use along safe paths. If you ever have any questions, or you think that something is not working the way it should, please don’t hesitate to contact us. In 95% of all cases, problems like these can be resolved just by changing a few settings. You can contact our Customer Service by emailing support@salfeld.com or through our website. There, you will also find answers to some Frequently Asked Questions (FAQ).

If you like this manual as a PDF file (e.g. to print out), you'll find the download here:

Before you start...
Before installing User Control, you should take care of a few preliminary steps. We recommend that you back up your entire system (you should be already be doing this from time to time to prevent loss of data) and, if you have not already done so, you should set up user accounts.

Videos and Screencasts
Just in case you’re not a fan of thick manuals, we have made available some instructional videos that will acquaint you with various aspects of User Control. You will find these videos at

http://salfeld.com/software/videos/
1.1 User Accounts

To quote from a Microsoft Help and Support page: "User accounts can turn your Windows computer into a real family PC. It's like setting up each family member with his or her own computer: everyone has his own private area, where access is allowed only through a password, and a personal folder for saving data that is not accessible to anyone else - with one exception - the Computer Administrator. This is the only person who can set up user accounts, determine each user's privileges, and install applications. Whenever children have access to a computer, it is especially important to set up limited user accounts so that you can control which applications are installed and ensure that important data cannot be accidentally deleted."

User Control is designed to work seamlessly with Windows’ user accounts. This makes it possible to set time limits, program limitations and Internet filters for each Windows user. Likewise, it is possible to have no restrictions at all for a particular user (such as a parent’s user account). For this reason, we recommend setting up a parents’ user account with a password, and without any restrictions. You can administer user accounts in Windows by going to Start -> Control Panel -> User Accounts. Likewise, in User Control, you can use the Overview page and press the "Manage Users" button.

Q: Can User Control be used to monitor Administrator accounts, too?
For the reasons mentioned above, we recommend that you grant your children only limited user privileges. However, there are some games that can be played only with an Administrator account; so a limited account will not suffice. User Control can also monitor Administrator accounts. An Administrator can normally alter other user accounts and change the system time. Both of these functions can be deactivated from User Control’s System + Security page.
1.2 **First Installation**

**Installation and First Startup**
Download the program from our home page (if you have not already done so) and start the installation. Or, if you have one of our CD's, start the setup program directly from the CD.

During the installation, you can select a directory in which to install User Control's configuration program. Please note that the actual monitoring software is not located in this directory. If the directory is accidentally or purposely deleted by one of your children, this will not affect the way that User Control functions.

1.3 **Subsequent Installations**

You can, at any time, install a current version of User Control, such as one that you downloaded from our home page, over an existing one. You do not need to remove the previous version first. User Control recognizes data of previous versions and asks you during the installation if these are to be transferred to the new one. The following notice appears whenever a previous version of User Control is found:

![Question dialog](image)

If you answer "Keep database", all the data is transferred to the new version. If, for any reason, User Control has stopped working correctly (in the case of rejected time extensions or incorrect time measurement, etc), you should select "Database RESET". This will return User Control to its original settings. (All existing settings will be lost.)
1.4 Enter Password

Entering a Password
The first time that you start the program, you will be prompted for a password for accessing User Control. You will need this password each time that you want to make changes to User Control's settings. You will also need the password in order to uninstall User Control through Control Panel. Please make sure that you choose a "secure" password. For example, don't use the name of your dog or anything that someone could easily guess.

![Set password](image)

Please enter an E-Mail address here, if you would like to receive E-Mail reports or if you want to turn on the Internet Remote function. You can always change your password or email address later on, using the Edit/Change Password menu item. Once you have chosen your password, you will see the program's first screen.
2 The Start Screen

2.1 Let's go - The "Start" page

In the upper right portion of the window, you can select a user. This selects the user to whom restrictions will apply. Users correspond to Windows’ user accounts. If you want to add, delete or modify a user, you must do so directly through Windows. When using User Control’s multi-user version, you can also select a remote computer (left drop down box in the upper right corner).

User Control's user interface consists of two main navigation items and the Start page entry. You may access these pages either directly through the navigation bar at the left edge of the screen or through the "Window" menu. Generally speaking, limitations set on a particular page apply only to the selected user (shown at the upper right). The exception is the "This PC" section. Settings on this submenu affect all users of the computer.

Users are not defined within User Control—the Windows interface must be used. Use Windows to add or delete users. By pressing the “Manage Users” button in the Overview, you can access Windows’ user management directly. Each time you start the program the “Start” screen will be displayed. It gives you an overview of common limits and settings. Links are colored blue, clicking them leads you directly to the specified menu location.
3 User Specific Settings

3.1 Security - Windows Security

3.1.1 Startmenu

Use this section to disable some start menu entries. Note that depending on your windows system not all entries are available. Be extremely careful with "DisableShutDown" and "DisableLogOff". These settings are system wide, e.g. if marked, it is also forbidden to shutdown system via the task manager or a third party program. Note that some restrictions are not available (depending on your Windows version).

Disable Shutdown / Remove from Start Menu
This option allows you to stop users from being able to shutdown the computer by disabling the shutdown command.

Remove LogOff from Start Menu
This setting allows you to remove the Log Off [Username] option from the Start menu.

Remove Run from the Start Menu
Removes the ability to launch commands or processes from the Start menu by removing the Run option.
User Control

Remove Search from the Start Menu
This restriction removes the Search feature from the Start Menu.

Disable Right Click in Start Menu
Disable the ability to right click in the start menu. Users can't change properties or browse to Explorer via start menu entries.

Disable Control Panel in Start Menu
This restriction removes Control Panel from the Start Menu. The specified user can't access the control panel any more.

Disable new simple Start Menu (only XP)
Disables the new simple Start menu and forces the classic Start menu.

Remove My Documents from Start Menu
This restriction removes My Documents which is shown under the Documents folder on the Start Menu.

Remove My Pictures from Start Menu
This restriction removes My Pictures from the Documents folder on the Start Menu.

Remove My Music from Start Menu
This restriction removes My Music from the Documents folder on the Start Menu.

Remove Recent Documents
This setting can be used to remove the recent Documents folder from the Start Menu.

Remove Control Panel and Printer
This restriction removes the Control Panel, Printers and Network Connection settings from the Start menu.

Remove Help Option from Start Menu
This restriction removes the Help option from the Start Menu.

Remove Favorites from Start Menu
This setting allows you to remove the Favorites folder from the Start Menu.

Remove Common Program Groups from Start Menu
Disables the display of common groups when the user selects Programs from the Start menu.

Hide Start Menu Subfolders
This setting can be used to hide any custom sub-folders from being shown in the top section of the Start Menu.
3.1.2 Explorer

Hide All Items on the Desktop
Enabling this option hides all the items and programs on the Windows desktop.

Hide the Internet Explorer Icon
This option hides the Internet Explorer icon from the Windows desktop.

Hide the Network Neighborhood Icon
This setting hides the Network Neighborhood icon which is shown on the Windows desktop (if network is installed).

Disable Save Settings at Exit
This setting disables any changes from being saved therefore allowing you to preserve a configured layout.

Hide the Taskbar Settings on the Start Menu
This restriction removes the Taskbar and Start Menu item from the Control Panel and the Properties item from the Start menu context menu.

Disable Taskbar Context Menus
This setting removes the context menus (right click on the taskbar) for the system tray, including the Start button, Tab control, and Clock.

Disable Task Manager
This setting disables the Windows Task Manager. Users are no more able to kill/view processes and make changes to the priority of processes.

Disable Task Manager / Change Password
This setting disables the 'Change Password' button on Taskmanager Window and the Windows Security dialog box. Enabling this setting stops casual users from being able to change the password.

Disable Task Manager / Lock Workstation
This setting disables the 'Lock workstation' button on Taskmanager Window. Enabling this setting stops casual users from being able to lock the PC.

Disable the Ability to Right Click on the Desktop
This setting removes the context menu that would normally appear when the user right clicks on the desktop or in the Explorer right results pane.

Remove the Start Banner on the Taskbar
"Hide the bouncing arrow and the "'Click Here to Begin'" caption that appear on the taskbar when you start Windows."

Remove File Menu from Explorer
This setting is used to Remove the File option from the Explorers toolbar.

Hide the Display Properties
This option disables the display settings control panel icon, and stops users from accessing any display settings.

Hide the Display Appearance Page
When enabled this setting hides the display settings appearance page.

Hide the Display Background Page
This option hides the background page stopping users from changing any background display settings.

Hide the Display Screensaver Page
This option hides the screen saver page from the display settings control, which stops users having access to change screen saver settings.

Hide the Display Settings Page
This option hides the Settings page from the display properties control.

Hide the Remote Administration Page
Enabling this function stops users from being able to change the remote administration settings for the computer.

Hide the Hardware Profiles Page
This setting when enabled hides the Hardware Profiles page from the System icon on the Control Panel.
Hide the Device Manager Page
This setting controls whether the Device Manager is visible, under System in the Control Panel.

Hide the File System Button
This option hides the File System button from the System icon on the Control Panel.

Hide the User Profiles Page
The user profile page controls whether all users share or have separate user profiles, access to this page can be disabled by enabling this setting.

Hide the Virtual Memory Button
This option hides the Virtual Memory button from the System icon on the Control Panel.

3.1.3 Network

Use this section to set several restrictions for your network configuration. It is possible to secure views on network neighborhoods and workgroups/domain connections. Further you can protect a variety of connections and options. Note that some restrictions are not available (depending on your Windows version).

Hide Entire Network in Network Neighborhood
Entire Network can be disabled, so users are confined to their own Workgroup or Domain.

Hide File and Printer Sharings
Enabling this options hides the file and printer sharing controls, stopping users from disabling or creating new file or printer shares.

Disable File Sharing
Enabling this options hides the file and printer sharing controls, stopping users from disabling or creating new file or printer shares.

Remove the Map and Disconnect Network Drive Options
This setting removes the Map Network Drive and Disconnect Network Drive buttons from the toolbar in Explorer and context menus.

Hide Workgroup Content from Network Neighborhood
Enabling this option hides all Workgroup contents from being displayed in Network Neighborhood.

Disable Printer Sharing, Restrict changes to Printer Sharing
Users can't add or delete shared printers in the network.

Hide Network Access Control Page
This setting removes access to the Access Control Page.

Hide Network Identification Page
This setting disables access to the Network ID page, which includes options to set the Computer Name, Workgroup and Description.

Disable Network Control Panel / Desktop Icon
This setting disables access to the Network ID page, which includes options to set the Computer Name, Workgroup and Description.

Disable Password Caching
This settings disables local caching of passwords and increases security to your local PC.

Restrict add and remove network components
Restrict add and remove network components in properties of LAN, RAS and other network connections.

Restrict changes to Advanced Settings
Restrict changes to Advanced Settings in properties of LAN, RAS and other network connections.

Restrict changes to advanced TCPIP configuration
Restrict changes to advanced TCPIP configuration in properties of LAN, RAS and other network connections.
Restrict deletion of public RAS connections
Restrict deletion of public RAS connections in properties of LAN, RAS and other network connections.
Restrict deletion of RAS connections
Restrict deletion of RAS connections in properties of LAN, RAS and other network connections.
Restrict changes to the Dial-up Preferences
Restrict changes to the Dial-up Preferences in properties of LAN, RAS and other network connections.
Enable Windows 2000 network connections for administrators
Enable Windows 2000 network connections for administrators in properties of LAN, RAS and other network connections.
Restrict access to component properties of a LAN connection
Restrict access to component properties of a LAN connection in properties of LAN, RAS and other network connections.
Restrict connecting and disconnecting a LAN connection
Restrict connecting and disconnecting a LAN connection in properties of LAN, RAS and other network connections.
Restrict access to properties of a LAN connection
Restrict access to properties of a LAN connection in properties of LAN, RAS and other network connections.
Restrict connecting and disconnecting a RAS connection
Restrict connecting and disconnecting a RAS connection in properties of LAN, RAS and other network connections.
Restrict access to properties of a RAS connection
Restrict access to properties of public RAS connections in properties of LAN, RAS and other network connections.
Restrict renaming of public RAS connections
Restrict renaming of public RAS connections in properties of LAN, RAS and other network connections.
Restrict renaming of LAN connections
Restrict renaming of LAN connections in properties of LAN, RAS and other network connections.
Restrict renaming of private RAS connections
Restrict renaming of private RAS connections in properties of LAN, RAS and other network connections.
(SP1)
Disable status statistics for an active connection
Disable status statistics for an active connection in properties of LAN, RAS and other network connections.

3.1.4 Internet Explorer

You want to set specified restrictions for your surfers? Here you can. For example, it is possible to allow surfing the web, but protect/disable the download option. Further on you can prevent users from changing the desktop wallpaper by internet explorer or printing the actual internet site etc... Be careful marking "No Menu File/Exit": The user is not able to end the explorer. This setting is only recommended for 24hours internet terminals. (but maybe if you are running 24/7 the Kiosk Mode is the better idea)

Disable the option of selecting a download directory
This setting is used to remove the SaveAs Button in Download. Available in Microsoft Internet Explorer 5 and 6.
Disable right-click context menu.
This setting is used to disable the Context Menu in IE Explorer. Available in Microsoft Internet Explorer 5 and 6.
Disable the Tools > Internet Options menu
This setting is used to disable Options in IE Explorer. Available in Microsoft Internet Explorer 5 and 6.

No changes to advanced settings
Prevent changes to advanced settings in the Internet Explorer setup and control panel functions (Restart to take effect).

No changes to Automatic Configuration
Prevent changes to Automatic Configuration in the Internet Explorer setup and control panel functions (Restart to take effect).

No changes to temporary file settings
Prevent changes to temporary file settings in the Internet Explorer setup and control panel functions (Restart to take effect).

No changes to calendar and contacts
Prevent changes to calendar and contacts in the Internet Explorer setup and control panel functions (Restart to take effect).

No changes to security certificates
Prevent changes to security certificates in the Internet Explorer setup and control panel functions (Restart to take effect).

No changes to default browser check
Prevent changes to default browser check in the Internet Explorer setup and control panel functions (Restart to take effect).

No Color changes
Prevent Color changes in the Internet Explorer setup and control panel functions (Restart to take effect).

No changes to connection settings
Prevent changes to connection settings in the Internet Explorer setup and control panel functions (Restart to take effect).

Disable the Connection Wizard
Disable the Connection Wizard in the Internet Explorer setup and control panel functions (Restart to take effect).

Disable font changes
Disable font changes in the Internet Explorer setup and control panel functions (Restart to take effect).

Disable changes to History settings
Disable changes to History settings in the Internet Explorer setup and control panel functions (Restart to take effect).

Disable changes to Home Page settings
Disable changes to Home Page settings in the Internet Explorer setup and control panel functions (Restart to take effect).

Disable Language changes
Disable Language changes in the Internet Explorer setup and control panel functions (Restart to take effect).

Disable Links changes
Disable Links changes in the Internet Explorer setup and control panel functions (Restart to take effect).

Disable Messaging changes
Disable Messaging changes in the Internet Explorer setup and control panel functions (Restart to take effect).

Disable changes to Profiles
Disable changes to Profiles in the Internet Explorer setup and control panel functions (Restart to take effect).

Disable changes to Proxy settings
Disable changes to Proxy settings in the Internet Explorer setup and control panel functions (Restart to take effect).

Disable Ratings changes
Disable Ratings changes in the Internet Explorer setup and control panel functions (Restart to take effect).
Disable Microsoft Wallet (if installed)
Disable changes to Wallet settings in the Internet Explorer setup and control panel functions (Restart to take effect).

Disables all options under Accessibility
Disables all options under Accessibility in the Internet Explorer setup and control panel functions (Restart to take effect).

Hide General Tab
Removes General tab in the Internet Explorer setup and control panel functions (Restart to take effect).

Hide Security Tab
Removes Security tab in the Internet Explorer setup and control panel functions (Restart to take effect).

Hide Content Tab
Removes Content tab in the Internet Explorer setup and control panel functions (Restart to take effect).

Hide Connection Tab
Removes Connections tab in the Internet Explorer setup and control panel functions (Restart to take effect).

Hide Programs Tab
Removes Programs tab in the Internet Explorer setup and control panel functions (Restart to take effect).

Hide Privacy Tab
Removes Privacy tab in the Internet Explorer setup and control panel functions (Restart to take effect).

Hide Advanced Tab
Removes Advanced tab in the Internet Explorer setup and control panel functions (Restart to take effect).

No changes Personal Certificate options
Prevents changing Personal Certificate options in the Internet Explorer setup and control panel functions (Restart to take effect).

No changes Site Certificate options
Prevents changing Site Certificate options in the Internet Explorer setup and control panel functions (Restart to take effect).

No changes Publisher Certificate options
Prevents changing Publisher Certificate options in the Internet Explorer setup and control panel functions (Restart to take effect).

No changes Security Levels for the Internet Zone
Prevents changing Security Levels for the Internet Zone in the Internet Explorer setup and control panel functions (Restart to take effect).

No Adding Sites to any zones
Prevents adding Sites to any zone in the Internet Explorer setup and control panel functions (Restart to take effect).

Disable AutoComplete for Webforms
Disables AutoComplete for forms in the Internet Explorer setup and control panel functions (Restart to take effect).

Never Prompt me to save password from being displayed
Prevents Prompt me to save password from being displayed in the Internet Explorer setup and control panel functions (Restart to take effect).

Disable the Internet Connection Wizard
Disables the Internet Connection Wizard in the Internet Explorer setup and control panel functions (Restart to take effect).

No changes to Temporary Internet Files
Prevents any changes to Temporary Internet Files in the Internet Explorer setup and control panel functions (Restart to take effect).

Disable Reset web Setting button
Disables the Reset web Setting button in the Internet Explorer setup and control panel functions (Restart to take effect).

Disable the links bar
Disable the links bar in Internet Explorer.
Disable the toolbar
Disable the ability to change toolbar selection in Internet Explorer.
Disable the ability to change toolbar selection
Disable the ability to change toolbar selection in Internet Explorer.
Disable the Favorites
Disable the Favorites in Microsoft Internet Explorer 5 and higher.
Disable the option of closing Internet Explorer
Disable the option of closing Internet Explorer
Always prompt user when downloading files
Always prompt user when downloading files. Available in Internet Explorer.
Disable the File > New command
Disable the File > New command in Microsoft Internet Explorer 5 and higher.
Disable the File > Open command
Disable the File > Open command in Microsoft Internet Explorer 5 and higher.
Disable the ability to Save As
Disable the ability to Save As in Microsoft Internet Explorer 5 and higher.
Disables the Forward and Back navigation buttons
Disables the Forward and Back navigation buttons in Microsoft Internet Explorer 5 and higher.
Disable Open in New Window option
Disable Open in New Window option in Microsoft Internet Explorer 5 and higher.
Remove Print and Print Preview from the File menu
Remove Print and Print Preview from the File menu in Microsoft Internet Explorer 5 and higher.
Disable the Full Screen view option
Disable the Full Screen view option in Microsoft Internet Explorer 5 and higher.
Disable the ability to view the page source HTML
Disable the ability to view the page source HTML in Microsoft Internet Explorer 5 and higher.
Remove Mail and News menu item
Remove Mail and News menu item in Microsoft Internet Explorer 5 and higher.
Disable the Find Files command
Disable the Find Files command in Microsoft Internet Explorer 5 and higher.
Disable changes to browsers bars
Disable changes to browsers bars in Microsoft Internet Explorer 5 and higher.
Remove the Option to Change or Hide Toolbars
This option locks the toolbars. User cannot right click the toolbar itself, or change the options from the View menu.
Disable the address bar
Disable the address bar in Internet Explorer.
3.1.5 Misc

Disable Active Desktop
This setting will disable the use of the Active Desktop feature.

Restrict Changes to Active Desktop Settings
This setting allows you to have Active Desktop enabled, but to restrict any changes to the settings.

Disable CD-Autorun
This setting controls which drives the AutoPlay feature is enabled on. When AutoRun is enabled, media is automatically started when it is inserted.

Disable Folder Options Menu
This setting allows you to hide the Folder Options function from the folder Tools menu. Allowing you to restrict access to numerous advanced folder features.

Disable Windows Update
This setting enables/disables the Windows Update feature which allows users to easily update Windows components and software over the Internet.

Disable Registry Editing Tools
This restriction disables the ability to interactively run the standard Microsoft registry editing tools such as REGEDIT and REGEDT32.

Disable Task Manager
This setting disables the Windows Task Manager. Users are no more able to kill/view processes and make changes to the priority of processes.

Disable the Addition of Printers
Any user can add a new printer their system, this option once enabled disables the addition of new printers to the computer.

Restrict Icons in Tray near clock (XP only)
Restricts the access to icons in the notification area (tray) near the clock. Only available in Windows XP.
3.2 Security - Desktop Security

You can use this section to place powerful restrictions on your Windows desktop. Protecting the desktop against changes is a high benefit for all public PCs used in schools, authorities or at work. All users you have restricted will find a desktop that you have set up that does not allow changing background desktop wallpapers; or moving, deleting or renaming icons. Every user that you have restricted will see only the desktop that you have set up.

**Important:** Restricting context menu items is only possible if you use an English-language version of Windows. If you are using another localized version of Windows, please contact us. We will help you install context menu restrictions on your localized Windows version. In this case, please contact support@salfeld.com via email.

All Restrictions in detail

**Disable all context menus and right click on Desktop**
Use this restriction to disable all context menus on the desktop. This setting applies to all icons on the desktop (for example shortcuts, program icons, system icons) and also to the context menu of the desktop (if the user clicks on an empty area of the desktop).
No SendTo shortcut
This restriction disables the "Send to" context menu item in all shortcut and program icons on the Windows desktop.

No Cut shortcut
This restriction disables the "Cut" context menu item in all shortcut and program icons on the Windows desktop.

No Copy shortcut
This restriction disables the "Copy" context menu item in all shortcut and program icons on the Windows desktop.

No Create Shortcut shortcut
This restriction disables the "Create Shortcut" context menu item in all shortcut and program icons on the Windows desktop.

No Delete shortcut
This restriction disables the "Delete" context menu item in all shortcut and program icons on the Windows desktop. It also disables keyboard's delete key.

No Rename shortcut
This restriction disables the "Rename" context menu item in all shortcut and program icons on the Windows desktop. It also disables the possibility of the keyboard shortcut F2.

No Properties shortcut
This restriction disables the "Send to" context menu item in all shortcut and program icons on the Windows desktop.

No Network Neighborhood context menu
If this option is set, users cannot access any context item of the "Network Neighborhood" system icon.

No My Computer context menu
If this option is set, users cannot access any context item of the "My Computer" system icon.

No My Documents context menu
If this option is set, users cannot access any context item of the "My Documents" system icon.

No Recycle Bin context menu
If this option is set, users cannot access any context item of the "Recycle Bin" system icon.

Notice regarding system icons: It depends on your system configuration if the five system icons above are shown on your desktop or not. If you are using Windows XP, these icons are only available if you choose the "Classic Start Menu" (via Start -> Rightclick -> Properties). Note, that it does not matter which Windows configuration you have—you can always set these restrictions.

No Quick Launch and tasks
This setting disables the Quick Launch bar and the tasks in the taskbar. Only the Start button and the tray area will be visible in the taskbar. Note that switching tasks via the keyboard shortcut Alt+Tab is still possible.

No Tray/Notification area
Disables the tray (or notification) area of the Windows taskbar. This is the rightmost area of the Windows taskbar, which contains the clock and icons of some currently running programs (including the
Fixed Wallpaper
One of the biggest problems for all admins who set up public machines is that users change wallpaper to unwanted images. Nearly every browser or graphic application has a feature called “Set as Wallpaper” that allows your users to change the wallpaper to any image they like. Use this function to set a "locked" wallpaper. The users will still be able to set a new desktop wallpaper, but it is restored to the wallpaper that you set within the next 10 seconds. If you want to set a fixed wallpaper, please be sure that this restriction is not active for yourself, then clear this restriction and press the "Apply" button once. Then set a the desired wallpaper directly in Windows. The wallpaper will appear in the preview below after for at least 10 seconds.
3.3 Security - Window Title

In this section, you see an overview of all blocked window titles and executable files (applications). The major disadvantage of locking .exe files is that users can rename them. So there is a big advantage to locking window titles: these cannot be renamed by users. Every Windows application has one or more window titles. In Windows-styled applications (for example applications like Solitaire, Calc, Microsoft Word) it is easy to locate the window title—it is the text in the title bar of the application. Locating window titles in applications that use full screens, such as games is more difficult. In this case, run the application and you will find the window title in the "Log Files" section. Please be careful if you lock Windows titles. Lock only applications and titles that you are sure of.

**Remember:** You can lock yourself out of the system by blocking the wrong window titles. You can also block an unwanted .exe File. If a user starts an .exe file with the name you have entered here, the application will be closed, and a warning message will be displayed. This control works also if the .exe file is moved to another folder.

Block all unwanted .exe files/applications or window titles (also temporarily) using the list box below. You can restrict .exe files/applications and/or window titles.
3.4 Internet

Block specific content
The latest version of User Control supports some internationally recognized standards of designating website content. Among these is the ICRA standard. It also contains a blacklist with several million unsuitable sites for children. This list is updated regularly. Choose from among eight thematic categories those to which you do not want your children to be exposed, such as chat or violence. You can select one or more categories to be filtered out. If the website owner has designated a page as falling within one of the above categories, the user will get a warning notice.

3.4.1 Category Filter

Filter: Details / Fast
Determine how exactly the Internet filter should inspect the visited websites (URLs). In addition to the actual URL itself, you can make use of the “Details” setting to evaluate website components (e.g. the Meta tags). This setting is “more thorough” but can possibly slow down the site from uploading. With the “Quick” setting, only the URL itself is inspected and the webpage may pop up more quickly in the browser.
Report URL
Select this button to report a website (URL) that has not yet been included in the current filter.

3.4.2 Blocked

You can use the "Internet - Prohibited" page to enter individual Internet pages (URL's or domains) or even specific terms that will cause a web page to be cut off. In this case, a warning message whose exact wording you can specify on the "General Internet" page will be displayed. You will find that just listing a few key words can prevent access to the principal undesirable sites. When you list words, the search will be by entire words only—meaning that the term "SEX" will not block sites containing the term "SEXuality." A site in the list of Authorized Websites will not be blocked even if it contains an offensive term. If you want to export or import the file, you can do that through the File > Export or File > Import menu. Do not forget to activate the Internet filter as well (by selecting the "Activate Internet filter" check box).

Block Internet Completely
Check this option if you wish to block all Internet applications for a designated user. If you enable this setting, any program that uses the http protocol to access the Internet will immediately be terminated. The only exception is for applications specified as Always Authorized on the Programs page.
3.4.3 Allowed

You can use the "Internet - Authorized" page to enter individual Internet pages (URL's or domains). You can choose between "Always Authorized" and "Time-Limited" pages. The first option is intended for websites that should be authorized without any restrictions. Using the "time-limited" option, you can determine how long per day, week, or month the site can be visited. Within the "time-limited" category, you can also set blocked times (just like blocked times for the PC or Internet use in general. Restricting time spent on a given site is especially useful for chat pages, online games, etc., where experience shows that children tend to spend a lot of time. You can use the Log Files page to get an idea of which sites these are.

Please note that authorized and time-limited sites are not parsed for prohibited terms. Therefore, you should only list sites here that do not require filtering. If you select the "Authorize only these websites" box, users will not be able to access any other sites than those listed. Do not forget to activate the Internet filter as well (by selecting the "Filter ON – Filter blocked websites" check box).

Block Internet Completely
Check this option if you wish to block all Internet applications for a designated user. If you enable this setting, any program that uses the http protocol to access the Internet will immediately be terminated. The only exception is for applications specified as Always Authorized on the Programs page.
3.4.4 Misc

Do not display Internet warnings & Neutral Warning Message
Enabling this setting prevents warning messages about prohibited sites and keywords from being displayed. Users will not receive any notification if they try to access an undesirable site. Instead, the browser will display a "Site not found" message. If you enable "Neutral Warning," the warning will not state that prohibited keyword "XXX" was found. Instead, a general message will be displayed.

Redirect on Warning
If there is a website warning you could redirect to a given page here.

Check also whitelist for unallowed keywords
By default the whitelist (Allowed URL) is not checked for Unwanted keywords. If you would like to do so, mark this option.

No Downloads & No Send Data
Select the "No Downloads" option in order to block downloads of .exe and .zip files from the Internet. No Send Data: Prevents the user from sending data to the Internet (http POST command). Please be careful with this setting, most common search engines like google use that POST command.
3.5 Programs - Overview

The Programs page allows various settings for individual programs (also known as applications or .exe files) and their times of availability. This page lets you authorize use of an application at any time, at specified times, or not at all. NEW: Besides the .exe name (the name of the executable file on your hard drive), applications are now identified by their actual name as well. This makes it much easier to identify an individual program. A user could rename the .exe file, but not the name of the application. There is also a new way to add programs to this list: Just drag a symbol from the start menu or the desktop into the list. This does away with the need to browse for the file. The Programs page lets you assign programs to the following categories:

**Blocked**
Use this tab to define which programs will *never* be available for use. These could be programs that are to be used only by you, for example.
Allowed
This is the tab of the programs that are always available for use. By default, the list includes Windows internal programs, anti-virus programs and other system programs. You can add other programs to the list, such as vocabulary training programs or other educational applications. This is a useful function if you do not want the computer to shut down after the PC time limit is used up, but instead keep certain applications available. You can set this option on the Settings page, under "When time expires." You can also cause the timer to be interrupted if one of these programs is running in the foreground. So, for example, when the vocabulary trainer is running, you can stop PC use time from being incremented, so that time for games is available later. This tab contains also the time-limited programs: Use time-limited to define programs for which you want to set time limits, or that you want to block at specific times. This gives you the capability of setting the same restrictions (including time offset) as on the Time Limits and Blocked Times pages. The only difference is that the restrictions apply only to individual applications.

Internet
Applications in this tab are subject to the time limits defined on the main "Time Limits" page under "Internet Available" Times or on the "Blocked Times" page as "Internet Blocked Times." By default, the list includes your principal browser, and any chat or email clients that User Control has detected. Programs listed in this area are considered to belong to a group: Even if several applications from the group are running at the same time, the elapsed time is incremented only once. So it does not matter if both your browser and your email program are running at the same time, or just one of them. Internet time is incremented only once whether one or more programs are running. When the Internet time limit is used up, or a blocked time period is encountered, none of the programs in the group remain available. You can also specify that this list should be maintained automatically. (Settings -> Internet)

Groups
These are shown in the overview only when there is at least one member in the group. The advantage of grouping is that all shooter games, for example, can be assigned to the same group. Elapsed time is incremented whenever any game or application in the group is active. If several applications in the group are running at the same time, the time is only counted once. Once the limit has been reached, no further members of the group can be started. The definition of group names and group available times is described under Advanced Settings -> Program Groups.

Explanation of the individual buttons:
Add: Press this button to select an application and assign it to one of the above-mentioned categories.
Delete: Select an entry from the table; then press this button to delete it. Delete All: Deletes the entire list for the selected user. Note: Are you wondering which .exe files you should prohibit? Take a look at the usage logs from time to time to see which files your users have been executing. If you find one that should not be run, you can add it to the list.
3.6 Programs - Details

When you add a program, you can determine how you want to authorize it:

**Allowed**
When this option is selected, the program is always authorized. Windows’ internal applications are already in the list. Add the applications that you want to authorize at all times, such as vocabulary trainers. You also have the option of authorizing only the applications specified here, once the PC time limit has been reached. This is done on the Settings page, in the “When time expires” pulldown list.

Another option is to “promote” the running of specific programs. To do this, select the “Pause all timers in foreground” check box. This will pause all other timers (such as Internet and PC time). This setting can be very useful, since when vocabulary trainers or education programs run, they will not impact other limits.
Blocked
Programs in this category can never be run. This can be useful when a PC is shared by several family members, so that younger children do not use older children's shooter games.

Time-Limited
This option lets you specify how long the program can run (time limits) and at what times it should be blocked (blocked times). These settings work in exactly the same way as the general PC and Internet time limits, and the PC and Internet blocked times. The only difference is that here, the restrictions apply only to particular programs. This option can be applied to restrict the availability of a specific shooter game, a chat program (as far as it not already restricted as an Internet program), or other applications that you do not want running all the time.

Internet Program
Programs in this category increment Internet time. You can restrict these on the Available Times and Blocked Times pages. By default, the most common Internet applications are automatically entered here. This area is treated as a group. This means that even if several applications are running at the same time, the time is incremented only once. When the limit is reached, none of the applications can be executed any longer. Add or delete applications to be counted toward Internet time usage.
3.7 Misc - Hide Drives

Use this section to hide specified Windows drives. Please note, that the drives will only be hidden, not locked. So it might be possible to access the drives and folders directly. If you want to block drives and folders completely use the Windows built in NTFS file rights.
3.8 Misc - Kiosk Mode

If you are running a public PC (e.g. in your showroom or on a trade fair) the section Kiosk Mode will help you to manage this public terminal. So its possible to run a specified program (e.g. a presentation or a control program for production) or run a website in User Control Browser (more information about this browser below) if the selected user logs in. You can also hide the Windows Desktop and disable Taskmanager so that no one will get access to your system settings.

Please note that you can only define one user as "Kiosk Mode" enabled. Tip/Security advice: If you are using this feature, make sure that the selected user is part of the limited user group. Never use an admin user for that purpose!
Enable Kiosk mode
Click this option to enable/disable the Kiosk mode.

Start Program automatically
If you want to start a special application automatically you can provide the *.exe file here. Tick "Do not allow unknown programs" to avoid that users are starting other programs. This option is the same like Programs -> Filterlevel -> Filter ON, Unknown Programs Blocked.

Use User Control Browser with this website:
If you tick this option, the built-in User Control browser starts with the given website. You can also determinate whether the URL bar is displayed or not. Its even possible to restrict closing this browser.

Other options
No Windows Desktop terminates explorer.exe right after startup/login, so no one can use the Windows Desktop to browse your files or change some Windows settings. If you choose this option, you are not able to shutdown the PC via Start menu (because there is no more Start menu). You have to use the power button of your PC to initiate the shutdown. It is also a good idea to disable task manager which can be called by pressing CTRL+SHIFT+ESC.

About User Control Browser:
User Control Browser is part of User Control is a really (really!) simple browser, which just displays a website. And nothing more. There are no fancy features like rightclicks, showing source code, doing downloads, bookmarking sites etc. So its ideal for just displaying your website. And not more.You can also run User Control Browser standalone. Its located in the User Control settings program location (2c: \program files\salfeld\usco\uscoweb.exe" by default).
3.9 Usage Logs - Charts

This section gives you a various overview of used PC times, Internet times, used programs and websites. Select the corresponding tab get get charts for programs, websites and your defined groups. Daily usage shows you a history of PC and Internet time of the last days. You can use the drop down next to the charts to select a period (you can choose between day, week or month).

Additional Options:
Press the Details button to get the text version and more details of your selection. In Details section you can also export or print the reports by clicking the "Report" button (see there).
3.10 Usage Logs - Details

Use this section to get a detailed report of elapsed times for PC, Internet, programs and websites. Select tab History to see what happens when on your PC. In Blocked tab you will find all blocked programs and websites. Groups shows you the elapsed times of your defined groups. Daily usage gives you an overview of the used times for the days in the past. Error log is internal and maybe requested by Salfeld support in case of any questions.

Actions:
Use Reset Times to reset all counted times for the selected user. The button "Block" allows you to block an entry (regardless it is an program file or a website). Button "block" changes to unlock in "Blocked" section, so it's possible to release blocked content there. Report brings up a printable report which could also be exported (e.g. to Excel or a text file). Button charts redirects you to Usage Logs -> Charts.
3.11 Usage Logs - E-Mail Report

User Control can inform you by email (without the user's knowing it) about programs being executed, time limits and websites visited. You can decide if you want to notified by email periodically, or just each time that the computer starts.

Important Notice:
You must have an active Internet connection in order to receive the email. This connection is not started or terminated by User Control. However, if you are using a DSL router, this connection will usually be started and ended automatically. If your PC is manually connected through a modem or ISDN card, notification emails will only be sent after the user has started a connection, for example, by surfing the Web. In this case, an email can only be sent once the user is online. This means that there may be a delay in the notification times that you have set up.
**Frequency:**
Set here the events you want to be notified by E-Mail. "PC Start" sends an E-Mail every time the PC starts/the user logs in, "PC Stop" sends an email each time a user logs off/PC is shut down. Select "Additional E-Mail" to receive an E-Mail after the selected period (enter the desired value in the minute field). Click "Repeat sending E-Mails" to get E-Mails regularly. "Daily statistics" sends you an E-Mail report once a day, "Unlock requests" each time a user requests unlocking an program or Internet site and "System Messages" each time a system relevant event occurred (e.g. entered a wrong password, set an extension etc.).

**Server:**
You can decide whether the email should be sent through our server or your own email account. If you want to use the internal mail engine (our server), then you only need to enter the recipient and the subject line. If you want to use your own email account, that is, your own mail server, you must give User Control access to your email account. You can obtain this information from your provider. Please note that your provider must offer email through the SMTP AUTH method for you to use this function.

**Test Email:**
Before you activate email notification, you should, in any case, click the "Test Email" button to make sure that your entries are correct and that you will be able to receive emails. If the test email is not delivered even when you select the internal email engine (delivery through our server), please check your firewall and anti-virus settings. Ensure that file c:\windows\system32\cchservice.exe has access to the Internet You can determine how to grant access to the Internet by referring to your anti-virus or firewall program's documentation.

E-Mail Report via our mailserver is part of the [Online Functions](https://www.salfeld.net).
4 PC Specific Settings

4.1 Users

The first column of the table shows the names of all users set up on your local system. User Control works in conjunction with Windows' user names and profiles. You cannot create a new user directly in User Control. If this list is empty or you want to set up other users on your PC, just press the "Add" button to go directly to Windows' user management. You can create new users or delete old ones there.

The second column, "Kind" shows you the kind of the user profile. This could be Administrator (=full rights) or Limited User (=standard rights). The 3rd column shows the Windows login counter until the profile has been created. Last access shows the Windows information on how the last login has been performed. The last column shows whether User Control is active for the user or not.

Information on buttons:
Show Times & Reset Times: Pressing this button gives you an overview of the user's elapsed times. Pressing the Reset Times button sets all counted times back to 00:00 for the selected user.
Disable/Enable Button: Click this button to enable or disable User Control for the specified user. Delete & Add button: Shows you a message that Adding and Deleting users could only be done directly in Windows. The message provides a way directly to jump directly into these Windows settings.
4.2 Settings - General

This page lets you establish basic settings for the program. These settings are in effect not just for the current user, but for all users. Here are the various possibilities:

![User Control Settings](image)

**File - Customized image in notices:**
Whenever a user receives a warning, such as that time has almost run out, an image of our choice is normally displayed. You can replace this image with your own image file, in .bmp, .gif or .jpg format. Press the "Open" button to select a file. If the file format is incorrect, or the image is later deleted or moved, our standard image will again appear. To cancel use of your own image later, press Open and then Cancel.

If the path is not found (or is inaccessible), the next time that the computer is started, User Control will automatically default to the local database again. Further information is available in the Network Installation topic. If you want to cancel the entry, press Open, and then Cancel.

**Use beep instead of warning windows (game mode)**
In addition to the warning displayed on the screen, an audible tone can be sounded (assuming an SB-compatible sound card). The audible tone is sounded only for advance warnings. This function comes in handy when DirectX applications, or games that overlay Windows screens, are running. In this way, your child will still get an audible warning when time is about to run out.
No icon in System Tray (Stealth Mode)
Prevents User Control from appearing as a small icon in the System Tray, next to the clock. This setting not only makes it less obvious that User Control is running, but it also prevents users from seeing how time that have used and how much is left by double-clicking the icon.

Delete usage log after
User Control logs the accumulated times for all applications, the daily, weekly and monthly times of PC and Internet use, as well as all URL's visited. You can determine after how many entries each log should be deleted.

4.3 Settings - Internet

Important:
Please note, that all the following settings take only effect if the Internet Filter is turned on for the specified user (Section Internet -> Activate Internet filter)

Synchronize time/date with the Internet
This option lets you set the time to an Internet clock every time that you start your computer. Depending on the security level chosen on the System/Security page, this synchronization can take place when you begin a PC session, or at regular intervals. This can be useful when an attempt is made to change the clock through the computer hardware, as through BIOS settings.

Internet Filter: Monitor all HTTP applications
User Control can monitor any application's Internet activity. It uses Port 80 to check for http traffic. If this option is checked, every application that uses Port 80 is monitored. This can, in some cases, as with games, lead to some unwanted side effects and program crashes. If you find that some online games no longer work in an acceptable manner, then clear the check box for this option. When you do this, only the applications registered as Internet applications on the Programs Page will be monitored.

Internet Filter: Show only authorized URL's
On the Internet - Authorized page, you can specify that only the websites that you have named will be authorized. If you select this option, then along with the notice, the user will see a list of the first few entries from this list formatted as links.

Internet Filter: Show unlock URL
If a prohibited web page was requested, a warning notice is displayed. If this option is selected, then a link that can release the requested page also appears. Your User Control password must be entered to release the page. If the option is not selected, then no link is displayed, and the URL can only be released when you change the settings.

Internet Filter: Show Unlock Requests
If a prohibited web page was requested, a warning notice is displayed. If this option is marked, the user is able to click a "Unlock Request" link. In this case, the entry is saved in a list accessible via menu Edit -> Unlock Requests. If this option is unchecked, the link is not available/visible for your users.

Automatically manage list of Internet applications
If you check "Automatically manage list," each application that establishes an Internet connection is automatically added to the list, and thus its elapsed time is measured. Please be aware that many games or multimedia applications make use of the Internet, and that they will therefore be added to this list. If you are in any doubt, set this option off.
4.4 Settings - Database/Network

This tab lets you repair the database or empty it completely. You should use this function only if you suspect that the database has been corrupted, as after a system crash. By pressing “Reset Database,” you can restore the database to its factory settings. You can also export the database to a file or import the entire database from a file. All of these functions require that the program be restarted afterwards.
4.5 Settings - Exclusions

User Control monitors a wide variety of applications. A few of these types of applications may occasionally stop working as you would like them to. You can add those programs to a list here. After making your changes, please restart your computer. Applications that you place in this list will no longer be thoroughly monitored by User Control. Settings on this tab apply to all users.
5 Special Functions

5.1 Menus

File Menu
Use "Open" to open a file of saved settings. Use "Save" or "Save As" to save your current settings. Import/Export lets you import or export a list authorized websites and prohibited terms. You can also use this item to import lists from earlier versions of User Control. Using "Stop Monitoring," you can completely deactivate User Control until the next time you start User Control or Windows. "Uninstall" will completely remove User Control from your computer. "Exit" will completely terminate the program. Any settings that you have not saved may be lost.

Edit Menu
Use "Copy" to copy the limits currently in effect to the clipboard. You can then select another user and paste these limits. The "Manage Users" item will take you to Windows' user management. You must set up users in Windows in order to reference multiple users in User Control. The "Advanced Settings" menu item will take you to User Control's Advanced Settings. User "Change Password" to change your password for this program. "Enter Serial Number" lets you convert the program to the registered version. You can order a serial number directly through the Internet. Just go to our home page, www.salfeld.com. The "Select Language" menu will let you view the interface in the language of your choice. Remember that the entries in the Start menu and the online help apply to the version that you have installed. The "Wizards" menu item lets you set up some basic limits with a few clicks. You can view the "Tips of the Day" to see information about the application each time that you open it.

Window Menu
Just like the left side of the main window, the Windows menu lets you jump to any page. This menu shows all the individual pages to which you can go.

Help Menu
Use Help (F1) to view the Table of Contents of this help file. Select Contents and Index to see the application's list of keywords and the index to the help file. "Service Code" is an internal function that should be used only at the request of our support staff. The Online Update function lets you check if a newer version of User Control has been released. If so, you can download it and install it on your computer at no cost. You must have an active Internet connection to do this. "Order" will take you directly to our online ordering page, or you can print an order form for fax orders. "About" shows the copyright notice and the current version for the program. This number is absolutely required if you have a support request.
5.2 Online Functions

What are the Online Functions?
In addition to the time limits, blocked times and other system restrictions present in User Control, there are the new Online Functions. These make it easy to keep User Control up-to-date—for example, by automatically loading blacklists of undesirable websites or peer-to-peer file-sharing programs directly from our server. Using our server's email function, you can have User Control's logs sent to any email address without providing any logon data.

Are these services free? Will they always be?
All of these functions require high-performance servers on the Internet. Since it costs money to maintain these servers, we cannot offer the above-mentioned functions completely free of charge. However, all registered users of User Control will have access to them without charge for 24 months from the date of purchase (or for a pro-rated term when upgrading from an older version). At the end of this period, you can extend your usage of these functions, or use User Control without these online features.

What exactly is included in the online functions?
The online functions include email notifications from our server (emails using another server are not included), the updating of web blacklists (lists of undesirable websites), updating of the list of file-sharing programs (prohibited programs page). Free program updates are also included.

Is this a subscription that will need to be renewed?
No. When you purchase User Control, these online functions are provided free of charge for 24 months. There is no automatic renewal. If you want to extend the use of these functions, you can do so on our website.

Can I still use User Control afterwards?
You can use all the functionality of User Control (excluding the online functions) for as long as you want. Functions such program restrictions, the web filter for specifying your own permitted and prohibited sites, system restrictions and the sending of emails using your own server are not affected. You can use all of these functions as long as you wish.

5.3 Network Options

User Control lends itself to network use in various ways. If each PC is to have the same settings applied using a central file (as in a training room), the local database can be synchronized with this central file. The settings for each of these options can be accessed at Settings -> Database/Network.
Local Database (Default)
This is the default option that uses a local database. In this mode of operation, you can view all the settings of another computer and change them. To do this, that computer must be turned on, and a network must have been set up. Then you can just select the name of the computer that you want to manage from the selection list under “PC Name.”

Synchronization with a central file
If you want all clients on a network to have the same settings and you want to maintain them all from one location, a central settings file is recommended. Here, all the settings of the individual clients are matched to those of the central file, and, when necessary, synchronized with it. From then on, you only need to apply changes to settings in the central file. If you choose this option, the settings are in effect for all users of all computers who are shown as “active” in User Control. It is not possible to differentiate between different users of a computer when using this method.

How to: Set up identical user accounts (including the same user names) on each PC; then install User Control on each PC. On one of these, start the configuration program. Select the restrictions that you want and press the Apply button. Next, go to Settings -> Database/Network. Once there, select “NETWORK: Settings from (server) file location.” Then press “Apply” and enter a network location that is accessible to all User Control clients. This location must then be entered on each of the clients (using the Open button). Then, the next time any of the clients is started, its local database will be synchronized with the central file. (For performance reasons, this synchronization takes place only for the particular user who has logged on to the client.)
6 Questions, Answers and Support

6.1 About the Trial Version

User Control may be downloaded and evaluated for use as a free shareware Evaluation Version. This will let you determine if the program does what you need it to do. Please take note, however: many years of work went into the making of this program and all of its predecessor versions, and that work must somehow be compensated. Therefore, if you find the program useful, you should order the registered version. The shareware version can only be evaluated for a thirty-day period. If the trial period is over all settings are kept and you could change it to a full version by entering your serial number. There is no need for a uninstall/re-install.

6.2 System Requirements

User Control runs on all common Windows operating systems such Windows 2000, Windows XP, Windows Vista, Windows 7 and Windows 8. As far as hardware, you need at least a Pentium with 1 GHz and 1 GB RAM and 50 MB free hard-disk space, a VGA graphics card, and a mouse. If you find that User Control slows down your normal daily work, we recommend turning off several options (especially monitoring of PC and Internet time, as well as limiting the time of no more than a few .exe files. Select Online Update from the Help menu to install the latest version.

6.3 Questions and Support

We always make an effort to keep our software as user-friendly as possible. However, from time to time, you may have a question that is not covered in the help file. Should you have a problem with this program:

1.) Consult the help
Look at the help file, using the index if necessary. You may find the solution for your problem there.

2.) Look on our website
Go to the FAQ + Support area of our website, www.salfeld.com, and you may find the answer to your question there.

3.) Download a newer version, if possible
See if there is a newer version of the program available on our website. Uninstall this version and install the latest version. Your problem might already have been taken care of. P.S.: Your access information and serial number will still be good for future versions!

If these steps should not produce results, please get in touch with us. We will try provide an answer for your problem as soon as possible.
Index

- A -
Add User 34
Advanced Autostart 27
Allow only spec. users 34
Allow URL temporarily 21
Allow User 34
Allowed URL 21
Always Allowed Programs 25
Always Authorized (EXE) 23

- B -
Block Download 19
Block Folders 28
Block Internet URL 20
Blocked Times 15

- C -
Combining limits 6
Contact 42

- D -
Database 37
Day Limit 6
Delete User 34
Disable Command Prompt 27
Disable Control Panel 27
Disable entries in Start menu 27
Disable Registry 27
Disable System Recovery 27
Disable Taskmanager 27
Disable Time/Date settings 27
Domain 40

- E -
Edit Menu 39
Email Notification 32
Email Password 4
Evaluation 42
Exclusion 38
Export Database 37

- F -
File Menu 39
Folder lock 28

- G -
General Settings 35

- H -
Help Menu 39

- I -
ICRA Filter 19
Import Database 37
Internet Counting 36
Internet Authorized 21
Internet Bad Keywords 19
Internet Blacklist 19
Internet Limit 6
Internet related Programs 25
Internet Settings 19
Introduction 1

- K -
Keywords 19

- L -
Locked Times 15
Log Error 30
Log Files 30
Log Internet 30
Log Programs 30
Log Websites 30
- M -
Main Window 5
Manage applications 25
Manage EXE 25
Menus 39
Monitor Internet Settings 36
Month Limit 6

- N -
Navigation 1, 5
Network 40
Neutral Warning 19
Never Allowed Programs 25
Never Authorized (EXE) 23
No Icon in Tray 35
Notification Email 32

- O -
Online Functions 40
Overview 5

- P -
Password 4
Password Hint 4
Path User Profiles 35
Pause timers 35
Problems with other applications 38
Program Groups 25
Program Management 25
Programs counting (EXE) 23

- Q -
Questions & Support 42

- R -
Remote 40
Repair Database 37
Reset Database 37

- S -
Security Level 27
Server Database 40
Shareware 42
Show Unlock URL 36
Synchronize Time with Internet 36
System Requirements 42

- T -
Time Limits 6
Trial Version 42
Try before you buy 42

- U -
Undesired Internet 20
User Management 34

- W -
Warnings 35
Week Limit 6
When time expires.. 35
Window Menu 39